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Licensing Information

Unless you are using a trial version, Silk Test requires a license.

Note: A Silk Test license is bound to a specific version of Silk Test. For example, Silk Test 19.5

requires a Silk Test 19.5 license.

The licensing model is based on the client that you are using and the applications that you want to be able

to test. The available licensing modes support the following application types:

Licensing Mode Application Type
Mobile Native « Mobile web applications.
e Android
« i0S
« Native mobile applications.
e Android
*« i0S
Full +  Web applications, including the following:
e Apache Flex
e Java-Applets
* Mobile web applications.
¢ Android
* i0S
« Apache Flex
e Java AWT/Swing, including Oracle Forms
e Java SWT and Eclipse RCP
¢ .NET, including Windows Forms and Windows
Presentation Foundation (WPF)
*  Rumba
¢ Windows API-Based
Note: To upgrade your license to a Full license,
visit http://www.microfocus.com.

Premium All application types that are supported with a Full
license, plus SAP applications.

Note: To upgrade your license to a Premium
license, visit http://www.microfocus.com.

Mobile Native Add-On In addition to the technologies supported with a Full or
Premium license, the mobile native add-on license offers
support for testing native mobile applications on Android
and iOS.

Licensing Information

9


http://www.microfocus.com
http://www.microfocus.com

SIlkANET

Silk4ANET is the Silk Test plug-in for Microsoft Visual Studio. Silk4ANET enables you to efficiently create and
manage functional, regression, and localization tests directly in Visual Studio. With Silk4NET, you can
perform the following tasks within Visual studio:

* Record tests.

« Develop tests using Visual Basic .NET.

» Develop tests using C#.

* Run tests as a part of a test plan in the Microsoft test environment.
* Run tests as a part of your build process.

* View test results.

For information on the tested versions of Visual Studio, refer to the Release Notes.
Silk4NET supports the testing of a broad set of application technologies.
For information about new features, supported platforms, and tested versions, refer to the Release Notes.

Designed for realizing automation benefits even when applied to complex tests, Silk4NET brings true test
automation capability directly to the developer’s preferred environment and lets you easily cope with
changes made in the test application. Additionally, the powerful testing framework of Silk4NET enables
high reusability of tests across multiple test projects, which further increases the achievable Return On
Investment (ROI). With less time spent on building and maintaining testing suites, your QA staff can
expand test coverage and optimize application quality.

Note: If you have opted not to display the start screen when you start Silk4NET, you can check for
available updates by clicking Help > Check for Product Update.

Do | Need Administrator Privileges to Run Silk4ANET?

You require the following privileges to install or run Silk4NET:

» Toinstall Silk4NET, you must have local administrator privileges.
e Toinstall Silk4NET on a Windows server, you must have domain-level administrator privileges.
« To run Silk4NET, you require full access rights to the following folders, including all subfolders:

e C:\ProgramData\Silk\SilkTest.

o« %APPDATA%\Roaming\SiIk\SilkTest.
« %APPDATA%\Local\Si Ik\SilkTest.

o %TEMPY%.

Automation Under Special Conditions (Missing
Peripherals)

10 | Silk4NET

Basic product orientation

Silk4NET is a GUI testing product that tries to act like a human user in order to achieve meaningful test
results under automation conditions. A test performed by Silk4NET should be as valuable as a test
performed by a human user while executing much faster. This means that Silk4NET requires a testing
environment that is as similar as possible to the testing environment that a human user would require in
order to perform the same test.


https://www.microfocus.com/documentation/silk-test/195/en/silktest-195-releasenotes-en.pdf
https://www.microfocus.com/documentation/silk-test/195/en/silktest-195-releasenotes-en.pdf

Physical peripherals

Manually testing the Ul of a real application requires physical input and output devices like a keyboard, a
mouse, and a display. Silk4ANET does not necessarily require physical input devices during test replay.
What Silk4NET requires is the ability of the operating system to perform keystrokes and mouse clicks. The
Silk4NET replay usually works as expected without any input devices connected. However, some device
drivers might block the Silk4NET replay mechanisms if the physical input device is not available.

The same applies to physical output devices. A physical display does not necessarily need to be
connected, but a working video device driver must be installed and the operating system must be in a
condition to render things to the screen. For example, rendering is not possible in screen saver mode or if a
session is locked. If rendering is not possible, low-level replay will not work and high-level replay might also
not work as expected, depend on the technology that is used in the application under test (AUT).

Virtual machines

Silk4NET does not directly support virtualization vendors, but can operate with any type of virtualization
solution as long as the virtual guest machine behaves like a physical machine. Standard peripherals are
usually provided as virtual devices, regardless of which physical devices are used with the machine that
runs the virtual machine.

Cloud instances

From an automation point of view, a cloud instance is not different to a virtual machine. However, a cloud
instance might run some special video rendering optimization, which might lead to situations where screen
rendering is temporarily turned off to save hardware resources. This might happen when the cloud instance
detects that no client is actively viewing the display. In such a case, you could open a VNC window as a
workaround.

Special cases

Application Such an application cannot be tested with Silk4NET. Silk4ANET needs to hook to a
launched target application process in order to interact with it. Hooking is not possible for
without any processes that do not have a visible window. In such a case you can only run system
window commands.

(headless)

Remote If Silk4NET resides and operates within a remote desktop session, it will fully operate
desktops, as expected.

terminal . _ . .

services, and Note: You require a full user session and the remote viewing window needs to
remote be maximized. If the remote viewing window is not displayed for some reason,
applications (all for example network issues, Silk4NET will continue to replay but might produce
vendors) unexpected results, depending on what remote viewing technology is used. For

example, a lost remote desktop session will negatively impact video rendering,
whereas other remote viewing solutions might show no impact at all once the
viewing window was lost.

If Silk4NET is used to interact with the remote desktop, remote view, or remote app
window, only low-level techniques can be used, because Silk4ANET sees only a
screenshot of the remote machine. For some remote viewing solutions even low-level
operations may not be possible because of security restrictions. For example, it might
not be possible to send keystrokes to a remote application window.

Known Silk4NET requires an interactively-logged-on full-user session. Disable anything that
automation could lock the session, for example screen savers, hibernation, or sleep mode. If this
obstacles is not possible because of organizational policies you could workaround such issues

by adding keep alive actions, for example moving the mouse, in regular intervals or at
the end of each test case.

Silk4NET
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i Note: Depending on the configuration of the actual testing environment and the
technologies that are used for the AUT, the virtualization, and the terminal
services, you may face additional challenges and limitations during the test
automation process.

Silk Test Product Suite

12 | Silk4NET

Silk Test is an automated testing tool for fast and reliable functional and regression testing. Silk Test helps
development teams, quality teams, and business analysts to deliver software faster, and with high quality.
With Silk Test you can record and replay tests across multiple platforms and devices to ensure that your
applications work exactly as intended.

The Silk Test product suite includes the following components:

« Silk Test Workbench — Silk Test Workbench is the quality testing environment that offers .NET scripting
for power users and easy to use visual tests to make testing more accessible to a broader audience.

« Silk4ANET — The Silk4NET Visual Studio plug-in enables you to create Visual Basic or C# test scripts
directly in Visual Studio.

« Silk4J — The Silk4J Eclipse plug-in enables you to create Java-based test scripts directly in your Eclipse
environment.

« Silk Test Classic — Silk Test Classic is the Silk Test client that enables you to create scripts based on
4Test.

« Silk Test Agents — The Silk Test agent is the software process that translates the commands in your
tests into GUI-specific commands. In other words, the agent drives and monitors the application you are
testing. One agent can run locally on the host machine. In a networked environment, any number of
agents can run on remote machines.



SILK TEST PRODUCT SUITE
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The sizes of the individual boxes in the image above differ for visualization purposes and do not reflect the
included functionality.

The product suite that you install determines which components are available. To install all components,
choose the complete install option. To install all components with the exception of Silk Test Classic, choose
the standard install option.

Enabling or Disabling Usage Data Collection

To help Micro Focus improve your overall testing experience, Micro Focus would like to collect some
information on how you use Micro Focus software and services. By accepting the terms of the License
Agreement while installing Silk4NET, you allow Micro Focus to collect information about how you use
Silk4NET and about the computer system on which Silk4NET is installed. Micro Focus does not collect any
personally identifiable information, for example your name or address, or any of your data files, for example
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scripts or passwords. By allowing Micro Focus to collect this information, you assist Micro Focus in
identifying trends and usage patters.

To enable or disable the collection of usage data by Micro Focus:

1. Click SIlk4ANET > About Silk4NET in the menu.
2. In the About dialog box, click Customer Feedback Options.
3. Select one of the following options:

» To enable usage data collection, click Yes, | am willing to participate.
» To disable usage data collection, click No, | would not like to participate.

4. Click OK.

Contacting Micro Focus

14 | Silk4NET

Micro Focus is committed to providing world-class technical support and consulting services. Micro Focus
provides worldwide support, delivering timely, reliable service to ensure every customer's business
success.

All customers who are under a maintenance and support contract, as well as prospective customers who
are evaluating products, are eligible for customer support. Our highly trained staff respond to your requests
as quickly and professionally as possible.

Visit http://supportline.microfocus.com/assistedservices.asp to communicate directly with Micro Focus
SupportLine to resolve your issues, or email supportline@microfocus.com.

Visit Micro Focus SupportLine at http://supportline.microfocus.com for up-to-date support news and access
to other support information. First time users may be required to register to the site.

Information Needed by Micro Focus SupportLine

When contacting Micro Focus SupportLine, please include the following information if possible. The more
information you can give, the better Micro Focus SupportLine can help you.

« The name and version number of all products that you think might be causing an issue.

e Your computer make and model.

» System information such as operating system name and version, processors, and memory details.
« Any detailed description of the issue, including steps to reproduce the issue.

« Exact wording of any error messages involved.

* Your serial number.

To find out these numbers, look in the subject line and body of your Electronic Product Delivery Notice
email that you received from Micro Focus.


http://supportline.microfocus.com/assistedservices.asp
http://supportline.microfocus.com

What's New In SIIKANET

Silk4NET supports the following new features:

Ul Automation Support

Silk Test 19.5 offers Microsoft Ul Automation (Ul Automation) as a new fallback support.

To better recognize controls when recording against Windows-based applications that have implemented
the Ul Automation provider interface, you can enable the Ul Automation support on machines that run on
Microsoft Windows 8 or later. This provides fallback support for applications that are based on the following
technologies:

« WPF
« WinForms
¢ Oracle JavaFX*

. QT
* PowerBuilder
» Delphi

* Microsoft Office

* JavaFX applications are detected out-of-the-box, without the need to manually enable the Ul Automation
support.

Cross-Platform Resulting

When running tests, Silk4NET now creates an easily shareable HTML report that you can view in your
favorite browser.

The report includes summary information about the test run, as well as detailed information about the
executed actions.

By default, Silk4NET writes both a TrueLog and an HTML report when running a test. You can select which
result formats Silk4NET should generate under Silk4ANET > Edit Options > TrueLog > Select result
format.

Usability Enhancements

This section lists usability enhancements that have been made in Silk Test 19.5.

Text recognition for WebDriver-based browsers
SilkANET now supports text recognition for WebDriver-based browsers.
Text recognition includes the following methods:

o« TextCapture

« TextClick

o TextExists

« TextRectangle
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Dynamically invoking methods when testing native mobile apps

To call Appium WebDriver methods that are not exposed through the API of your Silk Test client, Silk Test
now enables dynamically invoking methods on mobile devices.

Technology Updates

This section lists the significant technology updates for Silk Test 19.5.

New Microsoft Windows Versions

You can now leverage your test set by simply executing all your existing functional, regression, and
localization tests on the Windows 10 October 2018 Update and on Windows Server 2019.

New Mozilla Firefox Versions

In addition to the versions of Mozilla Firefox, which have been tested with the previous version of Silk Test,
Silk Test has now been tested with the following new versions of Mozilla Firefox:

* Mozilla Firefox 61
* Mozilla Firefox 62
* Mozilla Firefox 63

Note: This list includes the new versions of Mozilla Firefox that have been tested with Silk Test 19.5
until the release date of Silk Test 19.5. Silk Test 19.5 should be able to support newer versions of
Mozilla Firefox, even if these versions have been released after the release date of Silk Test 19.5.

New Google Chrome Versions

In addition to the versions of Google Chrome, which have been tested with the previous version of Silk
Test, Silk Test has now been tested with the following versions of Google Chrome:

e Google Chrome 68
e Google Chrome 69
* Google Chrome 70

Note: This list includes the versions of Google Chrome that have been tested with Silk Test 19.5 until
the release date of Silk Test 19.5. Silk Test 19.5 should be able to test with newer versions of Google
Chrome, even if these versions have been released after the release date of Silk Test 19.5.

New Microsoft Edge Version

In addition to the versions of Microsoft Edge, which have been tested with the previous version of Silk Test,
Silk Test has been tested for recording and replay with Microsoft Edge 44.17763, the Microsoft Edge
version for the Windows 10 October 2018 Update.

New Apple Safari Version

In addition to the versions of Apple Safari, which have been tested with the previous version of Silk Test,
Silk Test has now been tested with Apple Safari 12.

New Android Version

In addition to the Android versions, which have been tested with the previous version of Silk Test, Silk Test
has now been tested with Android 9.
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New iOS Version

In addition to the iOS versions, which have been tested with the previous version of Silk Test, Silk Test has
now been tested with iOS 12.

New macOS Version

You can now leverage your test set by simply executing all your existing functional, regression, and
localization tests for Apple Safari or iOS on macOS Mojave (10.14).

Java 11 Support

Silk4NET now supports testing applications that are based on Java 11.

New Java SWT Versions

Silk Test now supports testing applications that are based on Java SWT 4.8 and 4.9.
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Getting Started with SiIlkANET

Silk4NET enables you to create and execute automated functional and regression tests. Perform the
following actions to get started with Silk4NET:

1. Create a Silk4NET project.

2. Create automated Silk4ANET tests, either by recording actions or keywords, or by manually scripting the
tests.

3. Add the Silk4NET tests to your project. A project can include any combination of recorded tests and
manually scripted tests.

4. Execute the tests.

5. Analyze the test results.
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Working with SIlk4NET Projects

This section describes how you can use Silk4NET projects.

A Silk4NET project contains all the resources needed to test the functionality of your applications by using
Silk4ANET.

Note: To optimally use the functionality that Silk4NET provides, create an individual project for each
application that you want to test, except when testing multiple applications in the same test.

Creating a Silk4ANET Project

1. Click Silk4NET > New Project or File > New Project . The New Project dialog box displays.

2. Under Installed > Templates, click Visual Basic or Visual C#, select Test and then select Silk4NET
Project.

3. Type a name for the project into the Name field.
For the tutorial, type Tutorial.
4. Optional: Type a name for the solution into the Solution field.
5. Click OK. The Project Created dialog box opens.
6. Click Yes to start recording a new test or click No to create an empty project.
For the tutorial, click No.
If you have selected to start recording, the Add New Item dialog box opens.
7. In the Add New Item dialog box, select which type of test you want to record.

* To bundle the recorded actions into one or more keywords, select Silk4ANET Keyword-Driven Test.
* To record the test without creating keywords, select Silk4NET Test.

8. If you have selected to start recording, type a name for the new test into the Name text box in the Add
New Item dialog box.

9. Click Add.

10.1f you have selected to record a new Silk4ANET test, the Select Application dialog box opens. Select
the tab that corresponds to the type of application that you want to test:

« If you are testing a standard application that does not run in a browser, select the Windows tab.
* If you are testing a web application or a mobile web application, select the Web tab.
» If you are testing a native mobile application, select the Mobile tab.

11.To test a standard application, if you have not set an application configuration for the current project,
select the application from the list.

12.To test a web application or a mobile web application, if you have not set an application configuration for
the current project, select one of the installed browsers or mobile browsers from the list.

a) Specify the web page to open in the Enter URL to navigate text box. If an instance of the selected
browser is already running, you can click Use URL from running browser to record against the
URL currently displayed in the running browser instance. For the tutorial, select Internet Explorer
and specify http://demo.borland.com/InsuranceWebExtJS/ in the Enter URL to navigate text box.

b) Optional: If you want to test a web application on a desktop browser with a predefined browser size,
select the browser size from the Browser size list.

For example, to test a web application on Apple Safari and in a browser window which is as big as
the screen of the Apple iPhone 7, select Apple iPhone 7 from the list.

c) Optional: Select an Orientation for the browser window.
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d) Optional: Click Edit Browser Sizes to specify a new browser size and to select which browser sizes
should be shown in the Browser size list.

13.To test a native mobile application (app) if you have not set an application configuration for the current
project:
a) Select the mobile device, on which you want to test the app, from the list.
b) Click Browse to select the app file or enter the full path to the app file into the Mobile app file text
field.
Silk4NET supports HTTP and UNC formats for the path.
Silk4NET installs the app on the mobile device or emulator.

14.Click OK. If you have selected an existing instance of Google Chrome on which you want to replay a
test method, Silk4NET checks whether the automation support is included. If the automation support is
not included, Silk4NET informs you that Google Chrome has to be restarted. The application and the
Recording window open.

If you have selected to create an empty Silk4NET test, a new solution containing the Silk4NET project is
created. Additionally, a Silk4NET test is created in the project with the following language-specific file
name:

« UnitTestl.vb
« UnitTestl.cs

Note: You can also use the context menu in the Solution Explorer to add Silk4NET projects to an
existing solution.
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Creating SIIKANET Tests

Describes how you can create Silk4NET tests.

You can create new Silk4NET tests by recording user actions made against your AUT or by manually
scripting your test classes and methods in Visual Basic or Visual C#.

Adding a SIIkANET Test to a Project

You can only add Silk4NET tests to an existing Silk4ANET or Test project. If no Silk4NET or Test project
exists, create a Silk4NET or Test project before you try to create a Silk4NET test.

1.

Click Silk4NET > New Test or Project > Add New Item .

Note: If your solution contains more than one SilkANET projects, select the project to which you
want to add the new test from the list in the Project Selector.

The Add New Item dialog box opens.
Under Installed, click one of the following:

« If your project is a Visual Basic project, click Common Items > Silk4NET Test.

« If your project is a Visual C# project, click Visual C# Items > Silk4ANET Test.

Type a name for the test into the Name field and click Add. The Create a Silk4NET Test dialog box
opens.

Select how you want to create your Silk4NET test by clicking one of the following option buttons:

Record a Silk4NET test Record actions and verifications against your application under test
and generate a new test containing the recorded automation
statements.

Create an empty Silk4ANET Create an empty test that can be filled with automation statements
test later on.

For the tutorial, click Create an empty Silk4NET test.
Click OK.

If you have selected to record a new Silk4NET test, the Select Application dialog box opens. Select
the tab that corresponds to the type of application that you want to test:

« If you are testing a standard application that does not run in a browser, select the Windows tab.
« If you are testing a web application or a mobile web application, select the Web tab.
« If you are testing a native mobile application, select the Mobile tab.

To test a standard application, if you have not set an application configuration for the current project,
select the application from the list.

To test a web application or a mobile web application, if you have not set an application configuration for

the current project, select one of the installed browsers or mobile browsers from the list.

a) Specify the web page to open in the Enter URL to navigate text box. If an instance of the selected
browser is already running, you can click Use URL from running browser to record against the
URL currently displayed in the running browser instance. For the tutorial, select Internet Explorer
and specify http://demo.borland.com/InsuranceWebExtJS/ in the Enter URL to navigate text box.

b) Optional: If you want to test a web application on a desktop browser with a predefined browser size,

select the browser size from the Browser size list.
For example, to test a web application on Apple Safari and in a browser window which is as big as
the screen of the Apple iPhone 7, select Apple iPhone 7 from the list.

Creating Silk4NET Tests
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c) Optional: Select an Orientation for the browser window.

d) Optional: Click Edit Browser Sizes to specify a new browser size and to select which browser sizes
should be shown in the Browser size list.

To test a native mobile application (app) if you have not set an application configuration for the current

project:

a) Select the mobile device, on which you want to test the app, from the list.

b) Click Browse to select the app file or enter the full path to the app file into the Mobile app file text
field.
Silk4NET supports HTTP and UNC formats for the path.
Silk4NET installs the app on the mobile device or emulator.

10.Click OK. If you have selected an existing instance of Google Chrome on which you want to replay a

test method, Silk4NET checks whether the automation support is included. If the automation support is
not included, Silk4NET informs you that Google Chrome has to be restarted. The application and the
Recording window open.

If you have selected to record the test, the recorded test is added to your project. If you have selected to
add an empty test, an empty Silk4NET test is added to your project.

Note: You can also use the context menu in the Solution Explorer to add Silk4NET tests to your
Silk4NET or Test project.

Recording a Silk4NET Test

1.

Click Silk4NET > New Test or Project > Add New Item .

Note: If your solution contains more than one Silk4ANET projects, select the project to which you
want to add the new test from the list in the Project Selector.

The Add New Item dialog box opens.
Under Installed, click one of the following:

» If your project is a Visual Basic project, click Common Items > Silk4NET Test.

» If your project is a Visual C# project, click Visual C# Items > Silk4ANET Test.

Type a name for the test into the Name field and click Add. The Create a Silk4NET Test dialog box
opens.

Select Record a Silk4NET test and click OK.

If you have not set an application configuration for the current project, select the tab that corresponds to
the type of application that you are testing:

» If you are testing a standard application that does not run in a browser, select the Windows tab.
* If you are testing a web application or a mobile web application, select the Web tab.

» If you are testing a native mobile application, select the Mobile tab.

To test a standard application, select the application from the list.

To test a web application or a mobile web application, if you have not set an application configuration for
the current project, select one of the installed browsers or mobile browsers from the list.

a) Specify the web page to open in the Enter URL to navigate text box. If an instance of the selected
browser is already running, you can click Use URL from running browser to record against the
URL currently displayed in the running browser instance. For the tutorial, select Internet Explorer
and specify http://demo.borland.com/InsuranceWebExtJS/ in the Enter URL to navigate text box.

b) Optional: If you want to test a web application on a desktop browser with a predefined browser size,
select the browser size from the Browser size list.

For example, to test a web application on Apple Safari and in a browser window which is as big as
the screen of the Apple iPhone 7, select Apple iPhone 7 from the list.
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c) Optional: Select an Orientation for the browser window.
d) Optional: Click Edit Browser Sizes to specify a new browser size and to select which browser sizes
should be shown in the Browser size list.

8. To test a native mobile application (app) if you have not set an application configuration for the current
project:
a) Select the mobile device, on which you want to test the app, from the list.

b) Click Browse to select the app file or enter the full path to the app file into the Mobile app file text
field.

Silk4NET supports HTTP and UNC formats for the path.
Silk4NET installs the app on the mobile device or emulator.

9. Click OK. If you have selected an existing instance of Google Chrome on which you want to replay a
test method, Silk4NET checks whether the automation support is included. If the automation support is
not included, Silk4NET informs you that Google Chrome has to be restarted. The application and the
Recording window open.

10.Perform the interactions, which you want to record, with your application under test.

For additional information about recording a mobile application, see Recording Mobile Applications. For
information about the actions available during recording, see Actions Available During Recording.

11.When you are finished with recording, click Stop. The Recording Complete dialog box opens. From
this dialog box, you can click Playback to replay the recorded test.

« If you are using Visual Studio 2010, you can also access the Test View in Visual Studio, where you
can replay and manage your tests.

« If you are using Visual Studio 2012 or later, you can also access the Test Explorer in Visual Studio,
where you can replay and manage your tests.

The recorded interactions are added as a file to your project. The default file name of the generated file is
UnitTest<Index>.cs or UnitTest<lIndex>.vb, depending on the default programming language of
your project. For example, if you are recording the first test for a Visual Basic project, the name of the
generated file is UnitTestl.vb

y Note: You can also create a new project and record the new test into the new project.

Recording a Test on Microsoft Edge

Before you can record a Silk4NET test, you must have created a Silk4NET project.

When starting the interaction with a web application on Microsoft Edge, Silk4NET closes any open instance
of Microsoft Edge and starts a new browser. This new browser uses a temporary profile without add-ons
and with an empty cache. This instance of Microsoft Edge is closed when shutting down the Open Agent or
when starting to test another application outside Microsoft Edge.

f Note: You can currently not record keyword-driven tests on Microsoft Edge.

To record a new test for a web application on Microsoft Edge:

Select the project to which you want to add the new test.

In the toolbar, click Record Actions. The Add New Item dialog box opens.
Select Silk4ANET Test.

Type a name for the new test into the Name field.

Click Add.

In the Select Browser dialog box, select the browser that you want to use.

Optional: If you want to test a web application on a desktop browser with a predefined browser size,
select the browser size from the Browser size list.
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8. Optional: Select an Orientation for the browser window.

9. Click Record.

10.The Interactive Recording window opens and displays the web application. Perform the actions that
you want to record.

a) Click on the object with which you want to interact. Silk4NET performs the default action for the
object. If there is no default action, or if you have to insert text or specify parameters, the Choose
Action dialog box opens.

b) Optional: To chose an action for an object, which might not be the default action, right-click on the
object. The Choose Action dialog box opens.

c) Optional: If the action has parameters, type the parameters into the parameter fields.

Silk4NET automatically validates the parameters.

d) Click OK to close the Choose Action dialog box. Silk4ANET adds the action to the recorded actions

and replays it on the mobile device or emulator.

During recording, Silk4NET displays the mouse position next to the recording window. You can toggle
the location to switch between displaying the absolute mouse position on the device display and the
mouse position in relation to the active object. For additional information about the actions available
during recording, see Actions Available During Recording.

11.Click Stop. The Record Complete dialog box opens.
12.Click OK.

Replay the test to ensure that it works as expected. You can modify the test to make changes if necessary.

Recording a Test on Mozilla Firefox

Before you can record a Silk4NET test, you must have created a Silk4NET project.

To record a new test for a web application on Mozilla Firefox:

Select the project to which you want to add the new test.

In the toolbar, click Record Actions. The Add New Item dialog box opens.

Select Silk4ANET Test.

Type a name for the new test into the Name field.

Click Add.

In the Select Browser dialog box, select the browser that you want to use.

Optional: If you want to test a web application on a desktop browser with a predefined browser size,
select the browser size from the Browser size list.

8. Optional: Select an Orientation for the browser window.

9. Click Record.

10.The Interactive Recording window opens and displays the web application. Perform the actions that
you want to record.

a) Click on the object with which you want to interact. Silk4NET performs the default action for the
object. If there is no default action, or if you have to insert text or specify parameters, the Choose
Action dialog box opens.

b) Optional: To chose an action for an object, which might not be the default action, right-click on the
object. The Choose Action dialog box opens.

c) Optional: If the action has parameters, type the parameters into the parameter fields.

Silk4NET automatically validates the parameters.

d) Click OK to close the Choose Action dialog box. Silk4NET adds the action to the recorded actions
and replays it on the mobile device or emulator.

During recording, Silk4NET displays the mouse position next to the recording window. You can toggle
the location to switch between displaying the absolute mouse position on the device display and the
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mouse position in relation to the active object. For additional information about the actions available
during recording, see Actions Available During Recording.

11.Click Stop. The Record Complete dialog box opens.
12.Click OK.

Replay the test to ensure that it works as expected. You can modify the test to make changes if necessary.

Recording a Test on Google Chrome

Silk4ANET supports recording a test on Google Chrome 50 or later. For previous versions of Google
Chrome, Silk4NET supports only replaying test and recording locators.

Before you can record a Silk4NET test, you must have created a Silk4NET project.

f Note: You cannot record tests on Google Chrome versions prior to version 50.

To record a new test for a web application on Google Chrome 50 or later:

8.
9.

No oD

Select the project to which you want to add the new test.

In the toolbar, click Record Actions. The Add New Item dialog box opens.
Select Silk4NET Test.

Type a name for the new test into the Name field.

Click Add.

In the Select Browser dialog box, select the browser that you want to use.

Optional: If you want to test a web application on a desktop browser with a predefined browser size,
select the browser size from the Browser size list.

Optional: Select an Orientation for the browser window.
Click Record.

10.The Interactive Recording window opens and displays the web application. Perform the actions that

you want to record.

a) Click on the object with which you want to interact. Silk4ANET performs the default action for the
object. If there is no default action, or if you have to insert text or specify parameters, the Choose
Action dialog box opens.

b) Optional: To chose an action for an object, which might not be the default action, right-click on the
object. The Choose Action dialog box opens.

c) Optional: If the action has parameters, type the parameters into the parameter fields.

Silk4NET automatically validates the parameters.

d) Click OK to close the Choose Action dialog box. Silk4NET adds the action to the recorded actions
and replays it on the mobile device or emulator.

During recording, Silk4NET displays the mouse position next to the recording window. You can toggle

the location to switch between displaying the absolute mouse position on the device display and the

mouse position in relation to the active object. For additional information about the actions available
during recording, see Actions Available During Recording.

11.Click Stop. The Record Complete dialog box opens.
12.Click OK.

Replay the test to ensure that it works as expected. You can modify the test to make changes if necessary.

Characters Excluded from Recording and Replaying

The following characters are ignored by Silk Test during recording and replay:
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Characters Control
Menultem
tab Menultem
& All controls. The ampersand (&) is used as an accelerator

and therefore not recorded.

Actions Available During Recording

During recording, you can perform the following actions in the Recording window:

Action

Steps

Pause recording.
Change the sequence of the
recorded actions.

Select multiple actions.

Replay recorded actions.

Remove a recorded action.
Verify an image or a property of a

control.

Change the object map entry

Select a different locator

Click Pause to bring the AUT into a specific state without recording the actions,
and then click Record to resume recording.

To change the sequence of the recorded actions in the Recording window,
select the actions that you want to move and drag them to the new location.

To select multiple actions, press Ctrl and click on the actions or press Shift
and click on the first and the last action that you want to select.

To replay recorded actions from the Recording window, select the actions and
click Play. To select all recorded actions, click on Recorded Actions and then
click Play.

To remove a falsely recorded action from the Recording window, hover the
mouse cursor over the action and click Delete.

Move the mouse cursor over the object that you want to verify and press Ctrl
+Alt.

If you are recording against a web application or a mobile web app and if the
automatically generated object map entry for a recorded object is difficult to
read or contains special characters, you might want to change the object map
entry to something more readable. You can do this during recording by right-
clicking on the object and then expanding the Object identification area of the
Choose Action dialog. Then you can edit the object map entry in the Object
Map ID field. For example, the automatically generated object map entry for an
image in our demo application is http demo borland. If you look at the object
map, it is be difficult to understand what object this entry refers to. Changing the
object map entry to something like InsuranceWebHomePageBanner would
possibly provide more context. This functionality is available for all supported
desktop and mobile browsers except Internet Explorer.

If you are recording against a web application or a mobile web app and the
automatically generated locator for a recorded object does not meet your
requirements, you can click on the arrow in the Locator field and let Silk4ANET
generate alternative locator suggestions for you. All suggested locators
uniquely identify the object. This functionality is available for all supported
desktop and mobile browsers except Internet Explorer.

Manually Creating a SIlk4ANET Test

1. Add a Silk4NET test to your project.
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2. Optional: To add support for controls of a specific application technology, you must include an import
statement at the beginning of the test that references the application technology namespace, as shown
in the following examples:

"Visual Basic .NET
Imports SilkTest NtF.Wpf

Imports SilkTest_Ntf._XBrowser
Imports SilkTest_Ntf.Win32

//C#

using SilkTest.Ntf.Wpf;
using SilkTest.Ntf._XBrowser;
using SilkTest_Ntf.Win32;

3. Configure the base state of the test application. For example:

"Visual Basic .NET
Dim baseState = New BrowserBaseState(BrowserType.InternetExplorer,
"www .borland.com'™)
baseState .Execute()

//C#

BrowserBaseState baseState = new

BrowserBaseState(BrowserType. InternetExplorer, "www._borland.com'™);
baseState.Execute();

Note: The base state makes sure that the application that you want to test is running and in the
foreground. This ensures that tests will always start with the same application state, which makes
them more reliable. In order to use the base state, it is necessary to specify what the main window
looks like and how to launch the application that you want to test if it is not running. Creating a
base state is optional. However, it is recommended as a best practice.

4. Add test classes and methods that test the desired functionality of the test application.

Best Practices for Creating Test Scripts

The way in which you write your test cases might have a great impact on the performance and stability of
your test set. During recording, Silk4NET creates scripts that are as fast and stable as possible. However,
there might be circumstances that require you to manually create or edit test scripts. This topic provides
some general guidelines that might help you create test scripts that are maintainable, reusable, and lead to
stable tests.

* Name your tests consistently and ensure that test names are self-explaining. Try to make the names
correspond with the application under test and the tested functionality. For example, the test names
MyApp_SuccessfulLogin and MyApp_FailingLogin are far easier to understand for other users than
Untitled_42 and Untitled_43.

« Describe your test cases as thoroughly as possible in a comment. Without a good description of the test
case in natural language, someone who needs to change the implementing code might not be able to
comprehend what exactly the test is doing.

« Ensure that your application under test is at the proper state when the test case starts. Return the
application under test to the correct state before executing the actions in a test case.

« Ensure that your application under test is at a proper state when the test case finishes. If additional
tests depend on the outcome of the test, ensure that they can start. Return the application under test to
the correct state when the actions in a test case are executed.

« Whenever possible, ensure that your test cases are not depending on the results of other test cases.
When this is not possible, ensure that the test cases are executed in the right order.

« Add verifications to your tests, to test the correctness of your application under test as well as the
functional flow.

« Use keyword-driven testing to create highly reusable action sets. Bundle commonly used actions into
keywords, combine keywords that are often executed sequentially into keyword sequences, and execute
combinations of keywords and keyword sequences as keyword driven-tests.

Creating Silk4NET Tests
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To keep your tests maintainable and reusable, prefer writing multiple simple test cases that are
combinable to writing complex test cases.
To avoid redundancies in your test set, prefer updating existing test cases to adding new test cases.

Adding a Verification to a Script while Recording

Do the following to add a verification to a script during recording:

1.
2.

Begin recording.
Move the mouse cursor over the object that you want to verify and press Ctrl+Alt.

When you are recording a mobile Web application, you can also click on the object and click Add
Verification.

This option temporarily suspends recording and displays the Select Verification Type dialog box.
Select Verify properties of the TestObiject.

For information about adding an image verification to a script, see Adding an Image Verification During
Recording.

Click OK. The Verify Properties dialog box opens.
To select the property that you want to verify, check the corresponding check box.
Click OK. Silk4NET adds the verification to the recorded script and you can continue recording.

Adding a Locator or an Object Map Item to a Test Method
Using the Locator Spy

Manually capture a locator or an object map item using the Locator Spy and copy the locator or the object
map item to the test method. For instance, you can identify the caption or the XPath locator string for GUI
objects using the Locator Spy. Then, copy the relevant locator strings and attributes into the test methods
in your scripts.

1.
2.

Open the test class that you want to modify.

Click Silk4NET > Locator Spy. The Locator Spy and the application under test open. If you are testing
a mobile application, a recording window opens, representing the screen of the mobile device. You
cannot perform actions in the recording window, but you can perform actions on the mobile device or
emulator and then refresh the recording window.

Optional: To bring the application under test into the appropriate state before recording a locator, click
Stop Recording Locator. The actions that you perform in the application under test are no longer
recorded. To continue with the recording of a locator, click Start Recording Locator.

Optional: To display locators in the Locator column instead of object map items, uncheck the Show
object map identifiers check box.

Object map item names associate a logical name (an alias) with a control or a window, rather than the
control or window's locator. By default, object map item names are displayed.

Note: When you check or uncheck the check box, the change is not automatically reflected in the
locator details. To update an entry in the Locator Details table, you have to click on the entry.
Position the mouse over the object that you want to record. The related locator string or object map item

shows in the Selected Locator text box.
Note: If you are testing on a browser, the Selected Locator field displays the locator only when
you actually capture it.

Press Ctrl+Alt to capture the object.
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Note: Press Ctrl+Shift to capture the object if you specified the alternative record break key
sequence on the General Recording Options page of the Script Options dialog box.

7. Optional: Click Show additional locator attributes to display any related attributes in the Locator
Attribute table.

8. Optional: You can replace a recorded locator attribute with another locator attribute from the Locator
Attribute table.

For example, your recorded locator might look like the following:
/BrowserApplication//BrowserWindow//input[@id="loginButton"]

If you have a textContents Login listed in the Locator Attribute table, you can manually change
the locator to the following:

/BrowserApplication//BrowserWindow//input[@textContents="Login"]

The new locator displays in the Selected Locator text box.
9. To copy the locator, click Copy Locator to Clipboard.

In the Selected Locator text box, you can also mark the portion of the locator string that you want to
copy, and then you can right-click the marked text and click Copy.

10.In the script, position your cursor to the location to which you want to paste the recorded locator.
For example, position your cursor in the appropriate parameter of a Find method in the script.
The test method, into which you want to paste the locator, must use a method that can take a locator as
a parameter. Using the Locator Spy ensures that the locator is valid.

11.Copy the locator or the object map item to the test case or to the Clipboard.

12.Click Close.

Creating Silk4NET Tests
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Replaying Tests

This section provides detailed information on the various ways to replay your Silk4NET tests.

For example, you can run Silk4NET tests from Visual Studio or by using the command line.

Running SIlkANET Tests

By default, Silk4NET 19.5 or later uses a 64bit JVM for keyword-driven tests. To run keyword-driven tests
with Silk4NET, set the default processor architecture under Test > Test Settings > Default Processor
Architecture in the Visual Studio menu to x64. Alternatively, you can specify your own 32bit JVM for
Silk4ANET by setting the SILK_KEYWORD_DRIVEN_JAVA HOME environment variable.

This topic describes how you can run your Silk4NET tests in Visual Studio.

1. To view all the tests that are available in the selected project or solution:

* In Visual Studio 2010, click Test > Windows > Test View.
* In Visual Studio 2012 later, click Test > Windows > Test Explorer.

2. In the Test View or the Test Explorer, depending on which version of Visual Studio you are using,
select the tests that you want to execute.

3. Right-click on your selection and click one of the following:

* In Visual Studio 2010, click Run Selection.
* In Visual Studio 2012 or later, click Run Selected Tests.
To run all tests in the selected project or solution, click Run All in the Test View or the Test Explorer,
depending on which version of Visual Studio you are using.
4. If you are testing a web application, the Select Browser dialog box opens. Select the browser and click
Run.
Note: If multiple applications are configured for the current project, the Select Browser dialog box
is not displayed.
5. Optional: If necessary, you can press both Shift keys at the same time to stop the execution of the test.

6. When the test execution is complete, the Playback Complete dialog box opens. Click Explore Results
to examine the results of the tests with TrueLog or click OK to close the dialog box.

Note: When you execute your tests, and Visual Studio starts the components that are needed for the
execution of the tests, Visual Studio will clean up everything when the test execution is finished,
terminating the Open Agent and all open browser windows.

Replaying a Test from the Command Line

To run Silk4NET tests from the command line, you can use VSTest.Console.exe. This command line
executable is included in Visual Studio and does not require any additional tools in addition to Silk4NET to
be installed. For additional information on using the VSTest.console from the command line, refer to Using
VSTest.console from the command line.

To run your Silk4NET tests from the command line, perform the following actions:

1. Create a DLL with the tests to be executed.
For example, call the DLL myTestFile.dll.
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Note: You can include multiple test classes in a single DLL. All tests in the various test classes will
be executed.

2. Run the tests in the DLL by typing:
Vstest.console.exe [TestFileNames] [Options]

For example, to execute the tests in myTestFile_dl 1, type the following:
vstest.console.exe myTestFile._dll

Note: For information on the available command line options, refer to Using VSTest.console from
the command line.

3. To create a TrueLog for a test class, use the <SilkTestClass> annotation.
For example, to run the class MyTestClass with TrueLog enabled, use the following class header in your
script:

<SilkTestClass> Public Class MyTestClass

Then create the DLL, for example myTestClass.dl 1 and execute the tests from the command line by
typing:
vstest.console.exe myTestClass.dll

Running Tests in Parallel

You can use multiple MSTest processes to execute tests in parallel against multiple browsers or mobile
devices. For example, you can use this functionality when executing test from a continuous integration
server, or from Silk Central.

Silk Testby default supports parallel testing for the following browsers and platforms:

* Google Chrome.
* Mozilla Firefox.
« Web, native, and hybrid apps on the following platforms:

« Physical Android devices.
e Android Emulators.
* Physical iOS devices.

To disable parallel test replay, set the environment variable SILKTEST_ENABLE_PARALLEL_TESTING to
false.

f Note: Enabling parallel testing causes the Open Agent to handle each test-executing process

separately. Applications which have been tested in one Silk Test client cannot be tested from another
client, while the initial client is running. For example, you cannot test the same application alternating
between Silk4J and Silk4NET.

i Note: You cannot execute multiple test runs on the same mobile device at the same time. Before
running tests in parallel, ensure that enough devices or emulators are available. Any test runs that get
no mobile device or emulator assigned will fail.

Each parallel test run starts as a separate vstestconsole.exe or mstest.exe, which corresponds to one
browser or mobile device. You can specify the browser or mobile device that you want to associate with a
specific vstestconsole.exe or mstest.exe through the connection string. For additional information, see
Connection String for a Mobile Device or Connection String for a Remote Desktop Browser .

The following image shows testing multiple browsers in parallel:
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Browser 2

Browser 3

vstestconsole.exe Mobile Device 2

vstestconsole.exe N :> Mobile Device 3

Multiple processes starting simultaneously might each try to start the Open Agent on the machine on which
Silk4NET is running. Running the Open Agent multiple times on the same machine is not possible and will
cause Silk4NET to throw an exception. To avoid this, ensure that the Open Agent is running before starting
the parallel test runs.

The test results are stored in multiple TrueLog files, one for each test run. To ensure that the TruelLog files
are not overwritten, you can add placeholders to the TrueLog file name. For additional information, see
Setting TrueLog Options.

Note: If you are experiencing high memory consumption during testing, ensure that test results are
saved in the compressed TLZ file format, and not in the XLG format. Silk4NET does not support the
TrueLog API for parallel testing.

How Does SilkANET Synchronize Tests?

Many unexpected test failures are related to synchronization issues. Weak synchronization during test
replay might generate false negative results, making it difficult to detect actual application problems.
Synchronization errors are timing issues that heavily depend on the test environment, making these errors
difficult to reproduce and solve. For example, a synchronization error that occurs in a specific test
environment might never be reproduced in the development environment. Weak synchronization is one of
the most common reasons for an automation project to get unmanageable with a growing set of automated
tests.

Silk4NET provides automated test synchronization for all supported technologies, enabling you to build
robust and manageable test sets. During the replay of a test, Silk4NET ensures that the test always waits
until the AUT is ready to perform the next action. For a verification step in a test, Silk4NET ensures that any
preceding actions in the test are completed before performing the verification.

To adapt your tests to the specific behavior of your AUT, you can change the values of the following
synchronization timeouts:
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Synchronization timeout The maximum time in milliseconds that Silk4ANET waits
(OPT_SYNC_TIMEOUT) for the AUT to become ready during playback. The default
value is 300000 milliseconds.

Object resolve timeout The maximum time in milliseconds that the Find method
(OBJ_WAIT_RESOLVE_OBJDEF) searches for an object. The default value is 5000
milliseconds.

Note: To be able to successfully run tests under
load or on slow systems, for example a virtual
machine accessed through a slow connection,
Silk4NET occasionally increases the internal
timeout, for example while the AUT is starting and
when a dialog or window appears. As soon as the
AUT, dialog, or window is completely started,
Silk4NET reduces the timeout again to the value
you have specified for
OPT_WAIT_RESOLVE_OBJDEF.

Object resolve retry interval If SIk4ANET cannot immediately find an object, Silk4NET

(OPT_WAIT_RESOLVE_OBJDEF_RETRY)  will retry to find the object until the object resolve timeout
expires. The object resolve retry interval specifies the
time in milliseconds that Silk4NET waits before retrying to
find the object. The default value is 1000 milliseconds.

Object enabled timeout The maximum time in milliseconds that Silk4NET waits

(OPT_OBJECT_ENABLED_TIMEOUT) for an object to become enabled during playback. The
default value is 1000 milliseconds.

f Note: The timeouts do not overlap.

For detailed information about the automated synchronization that Silk4NET provides specifically for Web
applications, see Page Synchronization for xBrowser. For detailed information about the synchronization
that Silk4NET provides specifically for Ajax applications, see How to Synchronize Test Automation Scripts

for Ajax Applications.

In addition to the automated synchronization, Silk4NET also enables you to manually add wait functions to
your scripts. Silk4NET provides the following wait functions for manual synchronization:

WaitForObject Waits for an object that matches the specified locator. Works with an
xPath locator or an object map identifier.

WaitForProperty Waits until the property specified by the propertyName parameter gets
the value specified by the expectedValue parameter or until the timeout
is reached.

WaitForDisappearance Waits until the object does not exist or until the timeout is reached.

WaitForChildDisappearance Waits until the child object specified by the locator parameter does not
exist or until the timeout is reached.

If a test randomly fails with an ObjectNotFoundException, increase the Object resolve timeout, for
example to 30 seconds. For very specific long running operations, for example a click on an object that
displays after a long calculation with a progress dialog, manually add the WaitForObject method to the
test script, to wait until the object is found, or add the WaitForDisappearance method to the test script,

to wait until the progress dialog is no longer displayed.
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Automated synchronization example

Consider the following code sample, where Silk4NET tries to click on a button with the
caption Ok:
VB _NET code

Dim button = _desktop.PushButton("'@caption="0k"'")
button.Click()

// C# code
var button = _desktop.PushButton(*'@caption="0k"");
button.Click(Q);

To replay the actions in this code sample, Silk4NET performs the following
synchronization actions:

1. Silk4NET tries to find the button. If the Object resolve timeout runs out, Silk4NET
stops the replay and throws an exception.

2. Silk4NET waits until the application under test (AUT) is ready. If the Synchronization
timeout runs out before the AUT is ready, Silk4ANET stops the replay and throws an
exception.

3. Silk4NET waits until the button is enabled. If the Object enabled timeout runs out
before the button is enabled, Silk4NET stops the replay and throws an exception.

4. Silk4NET clicks the button.

5. Silk4NET waits until the application under test (AUT) is ready again.

Enabling the Playback Status Dialog Box

Enable the Playback Status dialog box to view the actions that are performed during the replay of a test.
This dialog box is very useful when replaying tests on another machine, for example on a remote Mac or on

a mobile device.

To enable the Playback Status dialog box:

1.
2.
3.
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Click Silk4NET > Edit Options.
Click the Replay tab.

To enable the Playback Status dialog box, check the OPT_SHOW_PLAYBACK_STATUS DIALOG
check box.

To display a video or screenshots of the application under test in the Playback Status dialog box, check
the OPT_PLAYBACK_ STATUS_ DIALOG_SCREENSHOTS check box.

Click OK.

Note: If you are testing on a remote Mac or on a mobile device, ensure that the Mac or device does
not switch off the screen during testing, otherwise the Playback Status dialog box will not display

anything.



Analyzing Test Results

To enable you to analyze your tests after executing them, for example to find out why and how a test has
failed, Silk4ANET generates test reports during test execution.

By default, Silk4NET writes both a TrueLog and an HTML report when running a test. You can select which
result formats Silk4NET should generate under Silk4NET > Edit Options > TrueLog > Select result
format.

Analyzing Test Results
After running a test, you can review the test results and analyze the success or failure of the test run.

1. Run a Silk4NET test. When the execution is finished, the Playback Complete dialog box opens.
2. Click Explore Results to examine the results of the tests.
3. Click through the results.

Silk4ANET captures a screenshot whenever a test fails.

HTML Reports

By default, Silk4NET creates an HTML report and a TrueLog report when running tests. Both report
formats include summary information about the test run and detailed information about the executed
actions.

When a test run is finished, you can access the HTML report from the Playback Complete dialog.

By default, the HTML report is created in a sub-directory of the directory in which the Visual Studio solution
file and the results of the Visual Studio Unit Testing Framework are located. You can change the location
under Silk4NET > Edit Options > TrueLog > TrueLog location.

Visual Execution Logs with TruelLog

TruelLog is a powerful technology that simplifies root cause analysis of test case failures through visual
verification. The results of test runs can be examined in TrueLog Explorer. When an error occurs during a
test run, TrueLog enables you to easily locate the line in your script that generated the error so that the
issue can be resolved.

Note: TruelLog is supported only for one local or remote agent in a script. When you use multiple
agents, for example when testing an application on one machine, and that application writes data to a
database on another machine, a TrueLog is written only for the first agent that was used in the script.
When you are using a remote agent, the TrueLog file is also written on the remote machine.

For additional information about TrueLog Explorer, refer to the Silk TrueLog Explorer User Guide, located in
(in Microsoft Windows 7) Start > Programs > Silk > Silk Test > Documentation or (in Microsoft Windows
10) Start > Silk.

You can enable TrueLog in Silk4NET to create visual execution logs during the execution of Silk4NET tests.
The TrueLog file is created in the working directory of the process that executed the Silk4ANET tests.

The default setting is that screenshots are only created when an error occurs in the script, and only test
cases with errors are logged.

Analyzing Test Results
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Enabling TrueLog

For new Silk4NET scripts, TrueLog is enabled by default. You can enable or disable TrueLog by checking or
un-checking the Enable TrueLog check box in the TrueLog tab of the Script Options dialog box. To open
the Script Options dialog box, click Silk4NET > Edit Options.

To enable TruelLog for existing Silk4ANET scripts, which are using the Visual Studio Unit Testing Framework,
you have to replace the TestClass attribute of all test classes in the script with the SilkTestClass
attribute.

To enable TrueLog for existing Silk4NET scripts:

1. Open the script that contains the test class for which you want to enable TrueLog.
2. Add the SilkTestClass attribute to the test class.

By default, the TrueLog is created in the TestResults sub-directory of the directory, in which the Visual
Studio solution file and the results of the Visual Studio Unit Testing Framework are located. To specify a
different location for the TrueLog, click Silk4NET > Edit Options to open the Script Options dialog box
and click Browse to the right of the TrueLog file field.

The Visual Studio solution file is the file in which the Silk4NET scripts are located. When the Silk4NET test
execution is complete, a dialog box opens, and you can click Explore Results to review the TrueLog for the
completed test.

Examples

To enable TrueLog for a class in a Visual Basic script, use the following code:

<SilkTestClass()> Public Class MyTestClass
<TestMethod()> Public Sub MyTest()
" my test code
End Sub
End Sub

To enable TruelLog for a class in a C# script, use the following code:

[SilkTestClass]
public class MyTestClass {
[TestMethod]
public void MyTest() {
// my test code

+
+

Changing the Location of the TrueLog

By default, the TrueLog is created in the TestResults sub-directory of the directory, in which the Visual
Studio solution file and the results of the Visual Studio Unit Testing Framework are located.

To specify another location for the TrueLog:

1. Inthe menu, click Silk4NET > Edit Options. The Script Options dialog box displays.
2. Select the TruelLog tab.
3. Click Browse to the right of the TrueLog location field.

When running a test in the current project, the TrueLog is saved to the specified location.
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TrueLog Sections

You can add sections to TrueLogs to add structure to complex scripts and to logically divide scripts into
smaller named parts.

TruelLog sections can be nested and the same name can be used for multiple sections, which means the
names do not have to be unique.

To create a new section in a TrueLog file, use the following code:
openTruelLogSection(''section_name'™)

To close the last TrueLog section that was opened, use the following code:
closeCurrentTrueLogSection()

Sections are automatically closed in the following cases:

e The test case ends.

e The test class ends.

e The test run ends.

* A keyword ends.

« An exception occurs.

The following code sample demonstrates the usage of TrueLog sections:

[TestMethod]
public void SubSections()

{
Agent.OpenTruelLogSection("'Section a");

Agent.LogInfo(*'In section a');
Agent.OpenTruelLogSection("'Section b');
Agent._LogInfo('In section b™);
Agent.CloseCurrentTrueLogSection();
Agent.LogInfo("In section a again');

}

For additional information on the supported methods, refer to the APl documentation of your Silk Test
client.

Capturing the Contents of a Web Page

To capture a screenshot of the the part of the web page that is currently visible in the browser window, you
can use the CaptureBitmap method. You have to specify the absolute or relative file path to the location
and the name for the image file as a parameter. For example:

//C# code
browserWindow.CaptureBitmap("'C:\Temp\MyPage.png');

"VB code
browserWindow.CaptureBitmap(**C:\Temp\MyPage.png')

To capture a screenshot of the entire contents of a web page as a single image, you can use the
CaptureFul IPageBitmap method. You have to specify the absolute or relative file path to the location
and the name for the image file as a parameter. For example:

//C# code
browserWindow.CaptureFul IPageBitmap("'C:\Temp\MyPage.png');

"VB code
browserWindow.CaptureFul IPageBitmap("'C:\Temp\MyPage.png')
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Why is TrueLog Not Displaying Non-ASCIl Characters
Correctly?

TrueLog Explorer is a MBCS-based application, meaning that to be displayed correctly, every string must
be encoded in MBCS format. When TrueLog Explorer visualizes and customizes data, many string
conversion operations may be involved before the data is displayed.

Sometimes when testing UTF-8 encoded Web sites, data containing characters cannot be converted to the
active Windows system code page. In such cases, TrueLog Explorer will replace the non-convertible
characters, which are the non-ASCII characters, with a configurable replacement character, which usually
is'?".

To enable TrueLog Explorer to accurately display non-ASCII characters, set the system code page to the
appropriate language, for example Japanese.

Why Does TrueLog Not Write Result Files During
Playback?

Silk4NET might display the following error message after playback:

Unable to explore result file because no result file was written. Ensure that you have sufficient permissions
and that the unit testing extension in the references of your Silk4NET project corresponds to the used
version of Visual Studio.

In this case, the reference to the unit testing extension is pointing to a different version of Visual Studio
than the one that you are currently using. For example, this can happen if you have migrated the Silk4ANET
project from a previous version of Visual Studio. To enable TrueLog to write result files, change the
reference to the wrong Visual Studio version so that it points to the correct version. Also ensure that the
Enable TrueLog check box in the TrueLog tab of the Script Options dialog box is checked. To open the
Script Options dialog box, click Silk4ANET > Edit Options.

Example

If the Silk4ANET projects reference Visual Studio 2012 and the version that you are using
is Visual Studio 2013, remove the reference to
SilkTest_Ntf._.VisualStudio2012.UnitTestingExtension from the Silk4ANET
projects and add the reference
SilkTest.Ntf._VisualStudio2013.UnitTestingExtension to the projects.
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Silk Test Open Agent

The Silk Test Open Agent is the software process that translates the commands in your scripts into GUI-
specific commands. In other words, the Open Agent drives and monitors the application that you are
testing.

One Agent can run locally on the host machine. In a networked environment, any humber of Agents can
replay tests on remote machines. However, you can record only on a local machine.

Starting the Silk Test Open Agent

Before you can create a test or run a sample script, the Silk Test Open Agent must be running. Typically,
the Agent starts when you launch the product. If you must manually start the Open Agent, perform this
step.

Click (in Microsoft Windows 7) Start > Programs > Silk > Silk Test > Tools > Silk Test Open Agent or
(in Microsoft Windows 10) Start > Silk > Silk Test Open Agent. The Silk Test Open Agent icon
displays in the system tray.

Stopping the Open Agent After Test Execution

You can stop the Open Agent by using the command-line option -shutDown or from a script, to ensure that
the agent does not continue running after the end of the test execution. The following code sample shows
how you can stop the Open Agent from the command line:

openAgent.exe -shutDown
To stop the agent from a script:

1. Open or create a script that is executed when the test execution is finished.
For example, open an existing script that is used for cleanup after test execution.
2. Add the ShutDown method to the script.

y Note: The Open Agent will restart as soon as the agent is required by another script.

Agent Options

This section describes the options that can be manipulated with the GetOption and SetOption
methods.

f Note: By default, you can set global options by choosing Silk4ANET > Edit Options in the menu.

To set or get agent options in a script, use the GetOption or SetOption methods. For instance, when
you type, Agent.SetOption(Options., the agent options display automatically in the active editor
window with the auto-completion and syntactical assistance technology. For instance, you might see the
following options in the active editor window:
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pplicationReady Timeouk

BitmapMatchCount
BitmapMatchInkerval
BitmapMatchTimeout
BitmapPixelTolerance
ButtonsToClose\Windows
ButtonsTaConfirmDialogs

ClosewindowTimeout
EnsureCbjectIsictive

e U L U e U R

CloseUnresponsivedpplications

An example for inserting an option into a script would be the following:

"VB .NET code

Agent._SetOption(Options.ApplicationReadyTimeout, 100000)

// C# code

Agent.SetOption(Options.ApplicationReadyTimeout, 100000);

Alternatively, you can use the agent option hame in scripts. For instance, you can type:

"VB .NET code

Agent._SetOption(*'OPT_APPREADY_TIMEOUT™, 100000)

// C# code

Agent._SetOption(""OPT_APPREADY_TIMEOUT"™, 100000);

.NET Option Name

Agent Option Name

Constant
Type

Description

out

BitmapMatchCount

BitmapMatchinterval
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ApplicationReadyTime OPT_APPREADY_TIMEOUT

OPT_BITMAP_MATCH_COUNT

OPT_BITMAP_MATCH_INTERVAL

BitmapMatchTimeout OPT_BITMAP_MATCH_TIMEOUT

NUMBER

INTEGER

REAL

REAL

Specifies the number of milliseconds
to wait for a newly launched
application to become ready. If the
application is not ready within the
specified timeout, Silk4NET raises an
exception.

Specifies the number of consecutive
snapshots that must be the same for
the bitmap to be considered stable.
Snapshots are taken up to the number
of seconds specified by
OPT_BITMAP_MATCH_TIMEOUT,
with a pause specified by
OPT_BITMAP_MATCH_INTERVAL
occurring between each snapshot.

By default, this is 0.

Specifies the time interval between
snapshots to use for ensuring the
stability of the bitmap image. The
shapshots are taken up to the time
specified by
OPT_BITMAP_MATCH_TIMEOQOUT.

By default, this is 0.1.

Specifies the total time allowed for a
bitmap image to become stable.

During the time period, Silk4NET takes
multiple snapshots of the image,




.NET Option Name Agent Option Name Constant Description
Type

waiting the number of seconds
specified with
OPT_BITMAP_MATCH_TIMEOUT
between snapshots. If the value
returned by
OPT_BITMAP_MATCH_TIMEOUT is
reached before the number of bitmaps
specified by
OPT_BITMAP_MATCH_COUNT
match, Silk4NET stops taking
snapshots and raises the exception
E_BITMAP_NOT_STABLE.

By default, this is 5.

BitmapPixelTolerance  OPT_BITMAP_PIXEL_TOLERANCE INTEGER Specifies the number of pixels of
difference below which two bitmaps
are considered to match. If the number
of pixels that are different is smaller
than the number specified with this
option, the bitmaps are considered
identical. The maximum tolerance is
32767 pixels.

By default, this is 0.

ButttonsToCloseWindo OPT_CLOSE_WINDOW_BUTTONS LIST OF Specifies the buttons used to close
ws STRING windows with the CloseSynchron
method.

ButttonsToConfirmDial OPT_CLOSE_CONFIRM_BUTTON LIST OF Specifies the buttons used to close

0gs S STRING confirmation dialog boxes that appear
when closing windows with the
CloseSynchron method.

CloseUnresponsiveAp OPT_KILL_HANGING_APPS BOOLEAN  Specifies whether unresponsive

plications applications are closed. An application
is unresponsive if communication
between the Agent and the application
fails, e.g. times out. Set this option to
TRUE when testing applications that
cannot run multiple instances. By
default, this is FALSE.

CloseWindowTimeout OPT_CLOSE_WINDOW_TIMEOUT NUMBER Specifies the number of milliseconds
to wait before the next close strategy is
tried. The Agent executes four close
attempts before failing, so the total
time before a close fails is four times
the value you specify.

Compatibility OPT_COMPATIBILITY STRING Enables you to use the Silk4NET
behavior of the specified Silk4NET
version for specific features, when the
behavior of these features has
changed in the latest version.
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Constant
Type

.NET Option Name Agent Option Name

Description

EnsureObjectisActive  OPT_ENSURE_ACTIVE_OBJDEF BOOLEAN

EnableAccessibility OPT_ENABLE_ACCESSIBILITY BOOLEAN

EnableMobileWebview OPT_ENABLE_MOBILE_WEBVIEW BOOLEAN
FallbackSupport _FALLBACK_SUPPORT

EnableUiAutomationSu OPT_ENABLE_UI_AUTOMATION_S NUMBER

pport UPPORT
HangAppTimeOut OPT_HANG_APP_TIME_OUT NUMBER
HighlightObjectDuring  OPT_REPLAY_HIGHLIGHT BOOLEAN

Playback
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Example strings:

e 12
« 11.1
+ 13.0.1

By default, this option is not set.

Ensures that the target object is active.
By default, this is FALSE.

TRUE to enable Accessibility when
you are testing a Win32 application
and Silk4NET cannot recognize
objects. Accessibility is designed to
enhance object recognition at the class
level.

FALSE to disable Accessibility.
By default, this is FALSE.

Note: For Mozilla Firefox and
Google Chrome, Accessibility is
always activated and cannot be
deactivated.

Enables mobile native fallback support
for hybrid mobile applications that are
not testable with the default browser
support.

By default, this is FALSE.

TRUE to enable Microsoft Ul
Automation support instead of the
normal Win32 control recognition. This
option might be useful when you are
testing a Win32 application and
Silk4NET cannot recognize objects.
AUTODETECT to automatically enable
Microsoft Ul Automation support for
JavaFX.

By default, this is FALSE.
Specifies the Unresponsive

application timeout, which is the
timeout for pending playback actions.

The default value is 5000 milliseconds.

Specifies whether the current object is
highlighted during playback.

By default, this is FALSE, which means
that objects are not highlighted by
default.




Constant
Type

.NET Option Name Agent Option Name

Description

KeyboardEventDelay OPT_KEYBOARD_INPUT_DELAY NUMBER

LIST OF
STRING

KeysToCloseDialogs OPT_CLOSE_DIALOG_KEYS

LocatorAttributesCase OPT_LOCATOR_ATTRIBUTES_CA BOOLEAN
Sensitive SE_SENSITIVE

MenultemsToCloseWin OPT_CLOSE_WINDOW_MENUS LIST OF
dows STRING
MouseEventDelay OPT_MOUSE_INPUT_DELAY NUMBER
ObjectResolveRetrylnt OPT_WAIT_RESOLVE_OBJDEF_R NUMBER
erval ETRY

ObjectResolveTimeout OPT_WAIT_RESOLVE_OBJDEF NUMBER
PlaybackMode OPT_REPLAY_MODE NUMBER

Sets the delay in milliseconds between
playback of keyboard strokes.

Be aware that the optimal number you
select can vary, depending on the
application that you are testing. For
example, if you are testing a Web
application, a setting of 1 millisecond
radically slows down the browser.
However, setting this to 0 (zero) may
cause basic application testing to fail.

Specifies the keystroke sequence to
close dialog boxes that open after
trying to close a window with the
CloseSynchron method. Examples
include: <ESC>, <Alt+F4>.

Set to Yes to add case-sensitivity to
locator attribute names, or to NO to
match the locator names case
insensitive. The names of locator
attributes for mobile Web applications
are always case insensitive, and this
option is ignored when recording or
replaying mobile Web applications.

Specifies the menu items used to
close windows with the
CloseSynchron method. Examples
include: "File/Exit*", "File/Quit*".

Specifies the delay in milliseconds
used before each mouse event.

Specifies the time in milliseconds to
wait before re-trying to find an object
that could not be immediately resolved
during playback. When the
ObjectResolveTimeout runs out, no
further retries are attempted.

Specifies the time in milliseconds to
wait for an object to be resolved during
playback. As soon as the object is
resolved, Silk4NET can recognize it.

Defines how controls are replayed.
Use low level to replay each control
using the mouse and keyboard. Use
high level to use the API to replay each
control. All controls have a default
playback mode assigned. When the
default replay mode is selected, each
control uses its default playback mode.
The default mode delivers the most

Silk Test Open Agent | 43




.NET Option Name

Agent Option Name

Constant
Type

Description

PostReplayDelay

RemoveFocusOnCapt
ureText

SuspensionTimeout

SyncTimeout

TransparentClasses
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OPT_POST_REPLAY_DELAY

OPT_REMOVE_FOCUS_ON_CAPT BOOLEAN

URE_TEXT

NUMBER

OPT_NTF_SUSPENSION_TIMEOU NUMBER

T

OPT_SYNC_TIMEOUT

OPT_TRANSPARENT_CLASSES

NUMBER

LIST OF
STRING

reliable results. Selecting low or high
level playback overrides the playback
mode of all controls with the playback
mode selected.

Possible values include 0, 1 and 2. O is
default, 1 is high level, 2 is low level.
By default, this is 0.

Specifies the time in milliseconds to
wait after invoking a function or setting
a property.

Set to Yes to take the focus off the
application under test during a text
capture. By default, this is set to NO,
leaving the focus on the application
under test. A text capture is performed
during recording and replay by the
following methods:

« TextClick

« TextCapture
+ TextExists

« TextRect

Specifies the maximum time in
milliseconds to wait for an answer from
the NTF. If the time is exceeded, the
communication between NTF and the
Open Agent is considered as
suspended.

Specifies the maximum time in
milliseconds for an object to be ready.

Note: When you upgrade from a
Test version prior to Silk Test 13.0
and you had set the
OPT_XBROWSER_SYNC_TIME
option, the Options dialog box wi
display the default value of the
OPT_SYNC_TIMEOUT, although
your timeout is still set to the valu
you have defined.

To simplify the object hierarchy and to
shorten the length of the lines of code
in your test scripts and functions, you
can suppress the controls for certain
unnecessary classes in the following
technologies:

*  Win32.
e Java AWT/Swing.

Silk

DUT

19%




.NET Option Name Agent Option Name Constant Description
Type

« Java SWT/Eclipse.

*« Windows Presentation Foundation
(WPF).

Specify the names of any classes that
you want to ignore during recording
and playback.

OPT_WPF_CHECK_DISPATCHER_ BOOLEAN For some WPF applications the Silk

FOR_IDLE Test synchronization might not work
due to how certain controls are
implemented, resulting in Silk4NET not
recognising when the WPF application
is idle. Setting this option to FALSE
disables the WPF synchronization and
prevents Silk4NET from checking the
WPF dispatcher, which is the thread
that controls the WPF application. Set
this option to FALSE to solve
synchronization issues with certain
WPF applications. By default, this is
TRUE.

WPFCustomClasses OPT_WPF_CUSTOM_CLASSES LIST OF Specify the names of any WPF

STRING classes that you want to expose during
recording and playback. For example,
if a custom class called MyGrid derives
from the WPF Grid class, the objects
of the MyGrid custom class are not
available for recording and playback.
Grid objects are not available for
recording and playback because the
Grid class is not relevant for
functional testing since it exists only for
layout purposes. As a result, Grid
objects are not exposed by default. In
order to use custom classes that are
based on classes that are not relevant
to functional testing, add the custom
class, in this case MyGrid, to the
OPT_WPF_CUSTOM_CLASSES
option. Then you can record, playback,
find, verify properties, and perform any
other supported actions for the
specified classes.

WPFPrefillltems OPT_WPF_PREFILL_ITEMS BOOLEAN  Defines whether items in a
WPFI1temsControl, like
WPFComboBox or WPFListBoX,
are pre-filled during recording and
playback. WPF itself lazily loads items
for certain controls, so these items are
not available for Silk4NET if they are
not scrolled into view. Turn pre-filling
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Constant
Type

.NET Option Name Agent Option Name

Description

XbrowserEnablelframe OPT_XBROWSER_ENABLE_IFRA BOOLEAN
Support ME_SUPPORT

XBrowserExcludelFra
mes

OPT_XBROWSER_EXCLUDE_IFR STRING
AMES

XBrowserFindHiddenln OPT_XBROWSER_FIND_HIDDEN_ BOOLEAN
putFields INPUT_FIELDS

XBrowserIncludelFram OPT_XBROWSER_INCLUDE_IFRA STRING
es MES
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on, which is the default setting, to
additionally access items that are not
accessible without scrolling them into
view. However, some applications have
problems when the items are pre-filled
by Silk4NET in the background, and
these applications can therefore crash.
In this case turn pre-filling off.

Specifies whether to enable iframe and
frame support for browsers. If you are
not interested in the content of the
iframes in a web application, disabling
the iframe support might improve
replay performance. For example,
disabling the iframe support might
significantly improve replay
performance for web pages with many
adds and when testing in a mobile
browser. This option is ignored by
Internet Explorer. This option is
enabled by default.

Every entry in the list defines an
attribute name and the corresponding
value. All iframes and frames that do
not match at least one of the entries
are considered during testing.
Wildcards are allowed, for example the
entry "src:*advertising*" would exclude
<IFRAME src=http://my.domain/
advertising-banner.htmli>. This option
is ignored by Internet Explorer. If the
list is empty, all iframes and frames are
considered during testing. Separate
multiple entries with a comma.

Specifies whether to display hidden
input fields, which are HTML fields for
which the tag includes
type=""hidden". The default value
is TRUE.

Every entry in the list defines an
attribute name and the corresponding
value. All iframes and frames that do
not match at least one of the entries
are excluded. Wildcards are allowed,
for example the entry "name:*form"
would include <IFRAME name="user-
form" src=...>. This option is ignored
by Internet Explorer. If the list is empty,
all iframes and frames are considered




.NET Option Name Agent Option Name Constant Description

Type
during testing. Separate multiple
entries with a comma.
XBrowserSynchronizati OPT_XBROWSER_SYNC_MODE  STRING Configures the supported
onMode synchronization mode for HTML or

AJAX. Using the HTML mode ensures
that all HTML documents are in an
interactive state. With this mode, you
can test simple Web pages. If more
complex scenarios with Java script are
used, it might be necessary to
manually script synchronization
functions, such as WaitForObject,
WaitForProperty,
WaitForDisappearance, or
WaitForChildDisappearance
Using the AJAX mode eliminates the
need to manually script
synchronization functions. By default,
this value is set to AJAX.

XBrowserSynchronizati OPT_XBROWSER_SYNC_TIMEOU NUMBER Specifies the maximum time in
onTimeout T milliseconds for an object to be ready.

Note: Deprecated. Use the
option OPT_SYNC_TIMEOUT

instead.
XBrowserSynchronizati OPT_XBROWSER_SYNC_EXCLUD STRING Specifies the URL for the service or
onURLEXxcludes E_URLS Web page that you want to exclude

during page synchronization. Some
AJAX frameworks or browser
applications use special HTTP
requests, which are permanently open
in order to retrieve asynchronous data
from the server. These requests may
let the synchronization hang until the
specified synchronization timeout
expires. To prevent this situation, either
use the HTML synchronization mode
or specify the URL of the problematic
request in the Synchronization
exclude list setting.

Type the entire URL or a fragment of
the URL, such as http://test.com/
timeService or timeService.

Separate entries by comma, for
example:

"VB _NET code
Agent.SetOption(OPT_XBROW
SER_SYNC_EXCLUDE_URLS,

{ "fpdownload.macromedia.
com",
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Type

"fpdownload.adobe.com™,
""download.microsoft.com"

1))

// C# code
Agent.SetOption(OPT_XBROW
SER_SYNC_EXCLUDE_URLS,

{ "fpdownload.macromedia.
com',
"fpdownload.adobe.com",
"download.microsoft.com"

D

Configuring the Connections Between the SIlkANET
Components

To enable connecting to a remote machine through a firewall or to enable connecting to a remote machine
securely by using HTTPS, you can configure the ports through which Silk4NET communicates with the
information service and the Open Agent.

When the Open Agent starts, a random available port is assigned to Silk4ANET and to the application that
you are testing. The port numbers are registered on the Silk Test information service (information service).

The information service provides the following information to Silk4ANET:

e The number of the port Silk4NET can use to connect to the Open Agent. Communication runs directly
between Silk4NET and the agent. You might need to configure this port for remote agent scenarios, for
example to avoid firewall conflicts.

« The browsers that are available on the machine on which the information service is installed.

* The mobile devices that are connected to the machine on which the information service is installed.

« The emulators that are available on the machine on which the information service is installed.

< The mobile browsers that are available on the previously mentioned mobile devices and emulators.

By default, the Open Agent communicates with the information service on port 22901. You can configure
additional ports for the information service as alternate ports that work when the default port is not
available. By default, the information service uses ports 2966, 11998, and 11999 as alternate ports.

Typically, you do not have to configure port numbers manually. However, if you want to test on a remote
machine and there is a port number conflict or an issue with a firewall between the machine on which
Silk4NET is installed and the test machine, you can configure the port number for the communication
between Silk4NET and the Open Agent on the remote machine or the port number for the communication
between Silk4NET and the information service on the remote machine. If you have multiple remote
machines on which you want to test, you can use different port numbers for each remote machine or you
can use the same available port numbers for all remote machines.

The following image shows the communication between Silk4NET, the information service and the Open
Agent.
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Configuring the Port to Connect to the Information

Service
Before you begin this task, stop the Silk Test Open Agent.

Typically, you do not have to configure port numbers manually. The information service handles port
configuration automatically. Use the default port of the information service to connect to the Open Agent.
Then, the information service forwards communication to the port that the Open Agent uses. However, you
can configure the information service port settings to avoid problems with a firewall by forcing
communication on a specific port.

By default, the port that is used to connect Silk4NET with the information service over a secure HTTPS
connection is port 48561. When you can use the default port, you can type hostname without the port
number for ease of use. If you do specify a port number, ensure that it matches the value for the default
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port of the information service or one of the additional information service ports. Otherwise, communication
will fail.

If necessary, you can change the port number that all clients use to connect to the information service.

1. Navigate to the infoservice.properties.sample file and open it.

« In a Microsoft Windows system, this file is located in C:\ProgramData\Si Ik\Silk Test\conf,
where “C:\ProgramData” is equivalent to the content of the ALLUSERSPROFILE environment
variable, which is set by default on Windows systems.

¢ On macOSs, this file is located in /Users/<user>/.silk/silktest/conf.

This file contains commented text and sample alternate port settings.
2. Specify whether Silk4NET should communicate with the information service over a secure connection
through HTTPS.

» To use a secure connection through HTTPS, set infoservice.https.enabled to true. This is
the default setting.

« To disable using a secure connection through HTTPS, set infoservice.https.enabled to
false.

3. Optional: If you have specified that you want to use a secure connection through HTTPS, you can
specify a different port that is not in use through which Silk4ANET should communicate with the
information service as the infoservice.default._https.port.

The default HTTPS port is 48561. Port numbers can be any number from 1 to 65535.

4. Optional: If you have specified that you do not want to use a secure connection through HTTPS, you
can specify a different port that is not in use through which Silk4NET should communicate with the
information service as the infoservice.default.port.

The default port is 22901.
5. Save the file as infoservice.properties.
6. Restart the Open Agent, the Silk Test client, and the application that you want to test.

Configuring the Port to Connect to the Open Agent

Before you begin this task, stop the Silk Test Open Agent.

Typically, you do not have to configure port numbers manually. The information service handles port
configuration automatically. Use the default port of the information service to connect to the Open Agent.
Then, the information service forwards communication to the port that the Open Agent uses. However, you
can configure the information service port settings to avoid problems with a firewall by forcing
communication on a specific port.

If necessary, change the port number that the Silk Test client or the application that you want to test uses to
connect to the Open Agent.
1. Navigate to the agent.properties.sample file and open it.

By default, this file is located at: %APPDATA%\S i Ik\Si IkTest\conT, which is typically C:\Users
\<user nanme>\AppData\Silk\SilkTest\conf where <user name> equals the current user
name.

2. Change the value for the appropriate port.
Typically, you configure port settings to resolve a port conflict.

Note: Each port number must be unique. Ensure that the port numbers for the Agent differ from
the information service port settings.

Port numbers can be any number from 1 to 65535.

Port settings include:
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e agent.vtadapter.port — Controls communication between Silk Test Workbench and the Open
Agent when running tests.

e agent.xpmodule.port - Controls communication between Silk Test Classic and the Agent when
running tests.

e agent.autcommunication.port - Controls communication between the Open Agent and the
application that you are testing.

e agent.rmi.port - Controls communication with the Open Agent and Silk4J.

e agent.ntfadapter.port — Controls communication with the Open Agent and Silk4NET.

« agent._heartbeat.port — Required to test with an Open Agent that is installed on a remote
machine.

Note: The ports for Apache Flex testing are not controlled by this configuration file. The assigned
port for Flex application testing is 6000 and increases by 1 for each Flex application that is tested.
You cannot configure the starting port for Flex testing.

3. Save the file as agent.properties.
4. Restart the Open Agent, the Silk Test client, and the application that you want to test.

Editing the Properties of the Silk Test Information
Service

Use the Iinfoservice.properties file to specify the port for the Silk Test Information Service, whether
to use a secure connection through HTTPS, or the capabilities that are applied each time Silk Test
executes a test on the machine on which the Silk Test Information Service is running.

1. Navigate to the directory in which the infoservice.properties.sample file is located.

¢ On a Windows machine, navigate to %PROGRAMDATA%\Si Ik\Si IkTest\conT, for example C:
\ProgrambData\Si Ik\SilkTest\conf.

¢ On macOS, navigate to ~/.silk/silktest/conf/.
2. Rename the file infoservice._properties.sample to infoservice.properties.

3. Specify whether Silk4NET should communicate with the information service over a secure connection
through HTTPS.

» To use a secure connection through HTTPS, set infoservice.https.enabled to true. This is
the default setting.
« To disable using a secure connection through HTTPS, set infoservice.https.enabled to
false.
4. Optional: If you have specified that you want to use a secure connection through HTTPS, you can

specify a different port that is not in use through which Silk4ANET should communicate with the
information service as the infoservice.default._https.port.

The default HTTPS port is 48561. Port numbers can be any number from 1 to 65535.

5. Optional: To redirect all HTTP requests to the HTTPS port, if you have specified that you want to use a
secure connection through HTTPS, set infoservice.http-to-https.enabled to true.

The default value is false.

6. Optional: If you have specified that you do not want to use a secure connection through HTTPS, you
can specify a different port that is not in use through which Silk4ANET should communicate with the
information service as the infoservice.default_port.

The default port is 22901.

7. Optional: To replace the certificates that are used by Silk Test for the HTTPS connection with your own
certificates, see Replacing the Certificates that are Used for the HTTPS Connection to the Information
Service.
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8. To specify capabilities, add the following line to the infoservice._properties file:
customCapabilities=<custom capability_1>;<custom_capability_2>; ...

Example: Running an iOS Simulator in a Specified Language

To always run a specific iOS Simulator on a Mac in the same language, for example
Japanese, specify the custom capabilities language and locale. To do so, add the
following line to the infoservice.properties file:

customCapabilities=language=ja;locale=ja JP

Replacing the Certificates that are Used for the HTTPS
Connection to the Information Service

When using a secure connection through HTTPS between Silk4NET and the information service, the
following self-signed certificate files are used:

* The keystore certificate file is used for the information service HTTPS server.
» The following certificate files are used for the machine on which the Silk4NET client is running:

« cacerts
« cacerts.pl2
o cacerts.penm

You can use OpenSSL and the Java keytool executable to replace these files with your own certificate files.

1. Ensure that OpenSSL and a JDK are installed on your machine.
2. Start the Java keytool executable from the bin folder of your JDK installation folder.

3. Create a private and public key pair in your private keystore file on the information service HTTPS
server:

keytool -genkey -alias jetty -keyalg RSA -keypass Borland -storepass
Borland -keystore keystore -validity 1095

4. When prompted to type a first and last name, type * as a wildcard for the host.

5. Export the information from your private keystore to a temporary certificate file named server .cer:
keytool -export -alias jetty -storepass Borland -file server.cer -keystore
keystore

This temporary certificate file is required to generate the certificate files for the machine on which the
Silk4NET client is running.

6. Create a certificate file named cacerts from the server.cer file.

keytool -import -v -trustcacerts -alias jetty -file server.cer -keystore
cacerts -keypass Borland -storepass Borland

7. Import the information from the cacerts file into the temporary certificate file cacerts.pl2.

keytool -importkeystore -srckeystore cacerts -destkeystore cacerts.pl2 -
srcstoretype JKS -deststoretype PKCS12 -srcstorepass Borland -deststorepass
Borland

8. Create the public keystore file cacerts.pem in the PKCS12 keystore format from the temporary
certificate file cacerts.pl2

openssl pkcsl2 -in cacerts.pl2 -out cacerts.pem -clcerts -nokeys
9. Deploy the files keystore, cacerts, cacerts.pl2, and cacerts.pem to the configuration folder:

e On a Windows machine, deploy the files to ¥PROGRAMDATA%\S1 1k\Si lkTest\conf, for example
C:\ProgramData\Silk\SilkTest\conf.
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¢ On macOS, deploy the files to ~/ .silk/silktest/conf/.

Remote Testing with the Open Agent

You can install Silk4NET on a remote machine and test an application on this remote location from the
Silk4NET that is installed on your local machine.

Note: If you want to test mobile applications on a mobile device that is connected to a remote
machine or on an Emulator or Simulator on a remote machine, or web applications on Apple Safari or
on a remote Microsoft Edge, you have to use a remote Silk Test information service instead of a
remote Open Agent.

Testing with a Remote Open Agent

To replay tests against an application on a remote machine with Silk4NET, perform the following actions:

1. Create a test against the application on the local machine.
2. Install the Open Agent on the remote machine.
For additional information, refer to the Silk Test Installation Guide.
3. Start the Open Agent on the remote machine.
4. In the test script, use the Connect method of the Agent class to connect to the remote Open Agent.
For example, add the following line to the script:
// VB _NET code
Private agent As RemoteAgent = Agent.Connect(‘'hostname:port'™)

// C# code
private RemoteAgent agent = Agent.Connect(''hostname:port');

For additional information, see Testing Applications in Multiple Ul Sessions on a Single Machine .
5. To execute a command in the test script on the remote machine, add the agent to the command.

For example, if the command in the local test script was SomeAgentFunction, change the command
to the following:

// VB _NET code

Dim d As Desktop = agent.Desktop
Dim baseState = New BaseState()
agent_ExecuteBaseState(basestate)
d.SomeAgentFunction()

// C# code

Desktop d = agent.Desktop;

BaseState basestate = new BaseState();
agent._ExecuteBaseState(basestate);
d.SomeAgentFunction();
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Base State

An application’s base state is the known, stable state that you expect the application to be in before each
test case begins execution, and the state the application can be returned to after each test case has ended
execution. This state may be the state of an application when it is first started.

When you create a class for an application, Silk4NET automatically creates a base state.

Base states are important because they ensure the integrity of your tests. By guaranteeing that each test
case can start from a stable base state, you can be assured that an error in one test case does not cause
subsequent test cases to fail.

Silk4NET automatically ensures that your application is at its base state during the following stages:

« Before a test runs
» During the execution of a test
« After a test completes successfully

Note: Silk4NET stores the base state and any Silk4NET options in the config.silk4net
configuration file. Silk4NET creates such a file for each Silk4NET project.

Note: Do not add more than one browser application configuration when testing a web application
with a defined base state.

You ca